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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 
http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals�
http://h20229.www2.hp.com/passport-registration.html�
http://www.adobe.com/�
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In This Version 

Service Manager Version 7.11, build 532 patch 19 (SM 7.11p19) includes several customer requested 
software enhancements and fixes. Refer to the sections below for information about the defects and 
enhancements included in this cumulative patch. 

New Parameters and JavaScript Global Methods 

The following parameters were introduced (or updated) in this release. 

cache_slots (updated) 

The default value of this parameter has been changed from 2003 (which is too low) to 9973 to improve 
system performance. For more information, see QCCR1E71918. 

For detailed information about this parameter, see the Service Manager help. 

usedmemcompmode 

This parameter determines how used memory is calculated. The default value is 0, which is the old method. 

Location:  
sm.ini  
Server’s OS command prompt 

Requires restart of Service Manager server?  
Yes 

Default value:  
0 

Possible values:  
0: Used=Committed + Reserved 
1: Used=Committed, No Log 
2: Used=Committed, Log 

Example usage 
Command line: sm -httpPort:13080 -usedmemcompmode:2 
Initialization file (sm.ini): -usedmemcompmode:2 

See QCCR1E71853. 

Web parameter: tracesoap 

This parameter defines whether to log SOAP information in the Web server. If you add the parameter 
"tracesoap=true" in the Web browser URL at login time, all request/response SOAP messages during the 
current session will be logged until you log out or the session expires. 

The SOAP information will be logged in the Web server. By default, it will be logged in the sm.log file located 
in the Web server's home directory. For example, C:\Program Files\Apache Software Foundation\Tomcat 
6\sm.log. The SOAP message logging is defined in WEB-INF/log4j.properties as follows: 

 

 log4j.logger.TraceSoap=ALL, R 
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Note: By default, the logging level is "ALL". It is recommended that you NOT change this setting. The root 
logger level setting in log4j.properties has no effect on the SOAP logging level. For example, no matter the 
root logger level is info, warn, or error, Service Manager always logs SOAP messages in the Web server. 

SOAP messages are logged with a "DEBUG" prefix, which look like the following: 

DEBUG http-8080-4 TraceSoap - request: 

DEBUG http-8080-4 TraceSoap - response: 

Location 
    Web browser URL  

Requires restart of Web application server? 
    No 

Default value 
    false 

Possible values 
    true or false 

Example usage 
    http://localhost:8080/webtier/index.do?tracesoap=true  

    Note: This parameter is valid only when set at login, and once set at login it will remain valid 
until you log out or the session times out. 

JavaScript method: SCFile.getMessages() 

Returns an array of messages generated by the Document Engine from a previous SCFile.doAction(). 

Syntax 

SCFile.getMessages(); 

Arguments 

There are no arguments allowed for this method. 

Return values 

Returns an array of messages from previous SCFile.doAction() call. 

Example 

This example does the following: 

• Uses the Document Engine add to create a new incident record from variable values. 

• Shows a validation failed due to invalid assignment group. 

• SCFile.doAction() returns 71, "validation failure". 

• SCFile.getMessages() returns messages generated from the Document Engine. 

var numberValue; 

var callbackContact; 

var categoryValue; 

var assignmentValue; 

var descriptionValue; 

var actionType; 

var resultionCodeValue; 

var resolutionValue; 
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function insertIncident( num, name, cat, group, desc ) 

{ 

print( "Creating new incident record..." ); 

var newIncident = new SCFile( "probsummary" ); 

newIncident.number = num; 

newIncident.callback_contact = name; 

newIncident.category = cat; 

newIncident.assignment = group; 

newIncident.description = desc; 

var rc = newIncident.doAction('add'); 

if ( rc == RC_SUCCESS ) 

{ 

print( "Success. Created new record " + newIncident.getText() ); 

return newIncident.number 

}e 

lse 

{ 

print( "Could not create record. " + RCtoString( rc ) ); 

print( "Reason: "+ newIncident.getMessages() ); 

return null 

 } 

} 

numberValue = "IM11121" 

callbackContact = "ADMINISTRATOR, SYSTEM"; 

categoryValue = "network"; 

assignmentValue = "HELPDESK"; 

descriptionValue = null; 

interactionID = insertIncident( numberValue, callbackContact, 

categoryValue, assignmentValue, descriptionValue ); 

Output 

           Category specified is invalid. Reason: Category specified is invalid. Could not create record. Validation 
failed creating new incident record... 

See QCCR1E68977. 

Case-Insensitive LDAP Login 

In Service Manager earlier than version 7.11p19, when LDAP is enabled for login, the case of the user name 
in the LDAP server must match that in the RDBMS. As of version 7.11p19, this match is no longer needed. 
When a user logs in, upper-case (FALCON), lower-case (falcon), and camel case (fAlcOn) can all be used for 
the user name. See QCCR1E70459. 

The following steps illustrate the new case-insensitive login behavior with the LDAP server and RDBMS: 

1 (User “admin” exists in the AD server.) Log in with either “admin” or “ADmin”.  

Result: The login is successful, and user “admin” is automatically added to the operator table. 
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2 Add user “john.smith” in the AD server, with a Display Name (CN) of “john.smith”. Log in as 
john.SMITH.  

Result: The login is successful, and user “john.smith” is automatically added to the operator table. 

3 Disable LDAP in sm.ini first (otherwise the LDAP user will be also deleted), and then do the following: 

a Manually delete “john.smith” from the operator table. 

b Manually add john.SMIth to the operator table. 

c Enable LDAP in sm.ini. 

d Log in as John.Smith. 

Result: The login is successful, and John.Smith is NOT automatically added to the operator table. 

The following table describes more about the LDAP login behavior in this release. 

Condition Behavior 

• The LDAP server is 
not available (because 
of wrong settings, 
network problems, 
etc.). 

• The user has a valid 
account in the 
RDBMS. 

 

The ldapnostrictlogin 
parameter is set to “1”. 

The user logs in successfully. 

The ldapnostrictlogin 
parameter is set to “0”. 

The user cannot log in. 

The ldapauthenticateonly parameter is enabled. The LDAP server is only used during the login 
process for authentication purpose only; after 
login, the LDAP server will not be used as a data 
source for db queries, even if some SM tables, like 
operator and contacts, were mapped to the LDAP 
server.  

The ldapauthenticateonly parameter is disabled. The LDAP server is only used during the login 
process for authentication purpose only; after 
login, the LDAP server will be used as a data 
source, and any queries on the operator or contacts 
file will also query the LDAP server. 

The “LDAP is Primary Data Source” option on the 
file/field LDAP mapping page is selected.  

The LDAP server is forcibly the primary data 
source for login and for other db operations against 
the relevant table.  

The “LDAP is Primary Data Source” option on the 
file/field LDAP mapping page is not selected. 

The LDAP server is forcibly the primary data 
source for login, but not for other db operations 
against the relevant table. 
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Upgrade of the LW-SSO Framework to Version 2.5 

The <webtier>/web/WEB-INF/classes/lwssofmconf.xml file has been updated to use LW-SSO framework 
version 2.5, which includes a new parameter secureHTTPCookie. 

Important: In the lwssofmconf.xml file, secureHTTPCookie is set to true by default. This parameter must 
be set to the same value (true or false) as secureLogin in the web tier configuration file (web.xml). For 
example, if you want users to access Service Manager using http instead of https (that is, secureLogin is set 
to false), you should also set secureHTTPCookie to false. 

Encryption of the Database Login Credentials 

The configure.jar in the server’s RUN folder has been updated. Running the configure.bat file will now 
encrypt the database login credentials (username/password) in the sm.ini file.  

Note: You can still manually specify clear-text database login credentials in the sm.ini file; however HP 
recommends that you encrypt the credentials as described below. 

To encrypt the database login credentials of an installed system: 

1 Extract the server package (.zip or .tar) in this patch, and copy the configure.jar file to your <SM server 
installation> directory. This will overwrite your old configure.jar file if you did not move it to somewhere 
else after your installation. 

2 Run the configure.bat file in the installed system, without loading the demo data. 

The database login credentials in the sm.ini file now have become encrypted strings instead of clear text. 

Support of AIX 6.1 and 7.1 

In this release, the Service Manager server has been certified on AIX versions 6.1 and 7.1.  

Important: The Service Manager server installer requires exactly IBM Java JDK 1.4 (1.4.2 or higher) 32-
bit, while IBM Java JDK 1.5 32-bit must be installed as a prerequisite for the Service Manager server to run 
on AIX. For this reason, both JDK 1.4 and JDK 1.5 must be installed as pre-requisites. 

 See also QCCR1E73365. 

Updated DLL Files for the ODBC Driver 

Three .dll files (Scodbc32.dll, sci18n.dll and sccl32.dll) have been updated to allow 16 joined array tables at 
most (see QCCR1E67090). For instructions on installing the updated files, see ODBC Driver Update 
Installation. 

Increased Maximum Size of Web Client Log File with Log Rotation Enabled 

The maximum file size for the web client log "sm.log" has been increased to 5000K and up to 10 rolling files 
can be kept. This is helpful for SOAP log tracing. See also QCCR1E74013. 

Displaying the Display List After Adding a Field to a QBE List 

After adding a column (field) to a QBE list by using the Modify Columns option, if the column has a Display 
List and Value List defined in Forms Designer, Service Manager always displays the QBE list with the 
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column’s Display List values instead of its Value List values (which are directly retrieved from the 
database). See server fix QCCR1E71099. 

Enhancements 

This patch release includes the following enhancement. 

Global ID Problem Solution 

QCCR1E73365  Service Manager is not supported on AIX 
6.1 or AIX 7.1.  

Service Manager is now supported on AIX 6.1 or 
AIX 7.1. 

Important: Both IBM Java JDK 1.4 (1.4.2 or 
higher) 32-bit and IBM Java JDK 1.5 32-bit 
must be installed as pre-requisites. 

Fixes 

This patch release includes the following fixes. 

Web Client 

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E31847 Users cannot add favorites in the 
Japanese localized version of Web Client.  

Users can add favorites in the Japanese 
localized version of Web Client.  

QCCR1E32210 Users are unable to view an attachment 
from the web client when 
getAbsolutePath() in Attachment.java 
returns greater than 255 characters.  
 
Note: This issue is most likely to occur on 
WebSphere systems, where the 
deployment path to the temp directory is 
prefixed by various WebSphere nodename 
and server names and an attachment file 
full path is dependent on the length of 
WAR file name and the installation path 
of the application server.  

The Web tier now supports long full paths 
(greater than 255 characters) for attachments 
when running on Linux, Unix, or Windows with 
an NTFS file system.  
Note: This issue still exists when, in rare cases, 
the web tier is running on Windows with a FAT 
file system.  
 
Note: If the user uses a very long file name or 
folder name, which causes the full path of the 
file to exceed 255 bytes, the user will not be able 
to delete the web application server's temporary 
file/folder generated on uploading the file 
(normally under the web application server 
installation directory). Deleting the temporary 
file/folder will fail with a system warning 
message that states the file name is too long. In 
this case, the user can do the following to delete 
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Global ID Problem Solution 

the file:  

1 Rename the temporary file to a short name, 
and then delete it.  

2 If the delete still fails, open the system 
command prompt, type "dir /x" to display 
the file's short name and then run the 
"rmdir {short name} /S" to delete the folder.  
 
This patch introduces a known issue in 
which the user cannot open an attachment 
on the Windows client if the file name is 
longer than 120 characters.  

QCCR1E59527 In environments deploying a case-
sensitive RDBMS in combination with a 
case-insensitive LDAP server for 
authentication, it might be impossible for 
users to successfully log in to Service 
Manager (SM).  
 
After login, the System Navigator 
displayed an empty tree and the main 
screen was partially rendered, which 
resulted in an inability to use SM.  

If LDAP is used for authentication, users can 
now successfully log in with a lowercase, 
uppercase, or mixed-case user name and use SM 
properly after login.  
 
Without LDAP authentication, the case-
sensitivity of login depends on the case-
sensitivity setting of the RDBMS.  
 
Note: To take advantage of this fix, both the 
SM server and clients must be upgraded to SM 
9.30p2 / SM 9.21.p5 / 7.11p19 or later.  

QCCR1E61880 After updating a few other fields of a 
problem ticket, the user received the 
following error message when updating 
the Affected CIs field using Fill: "Cannot 
find related information in device using 
query: true and logical.name#"Work In 
Progress"'.  

Reset the focus field so that when the focus is 
moved, the Web Tier will send the correct field 
to the background and fetch the correct records. 
The error no longer occurs.  

QCCR1E62821 Using the ALT+CTRL+C key command in 
the Web client to start spell check does not 
work when using the OS's Polish language 
pack. Instead, an HTML error page is 
displayed.  

Now, if the specified language dictionary cannot 
be found in Service Manager, a default 
dictionary will be used, which prevents the 
error page from being displayed.  

QCCR1E64183 There is no pop-up window to save the 
generated file when using Internet 
Explorer (IE) to generate an unload file.  
 
Note: It works fine with Firefox.  

The issue was resolved by changing the 
messages used to generate the unload file from 
<xml> to <div> tags, so that IE can render the 
messages properly. 

Known issue in IE7 /IE8:  

The generated unload file will be blocked by IE 
with the default settings and the following 
message will be shown at the top of current 
page: "To help protect your security, Internet 
Explorer blocked this site from downloading 
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Global ID Problem Solution 

files to your computer....”. 

To avoid this known issue, perform the 
following steps to apply specific setting in 
IE7/IE8:  

1 Click Tools > Internet Options. 

2 Click the Security tab, and then click 
Custom level.  

3 Scroll to the Downloads section of the list, 
and then, under “Automatic prompting for 
file downloads”, click Enable.  

4 Click OK, click Yes to confirm that you 
want to make the change, and then click OK 
again. 

QCCR1E67758 When searching for changes, fill-enabled 
data on a Comfill object that is Select Only 
cannot be deleted on the web client. If a 
user uses the Fill option, chooses a value, 
and then realizes the chosen value is 
incorrect, highlighting the value of the 
field and removing the value does not 
work. Pressing the backspace or delete key 
does not work either.  

A change was made to the Select Only property 
to allow deletion by accepting an empty value 
even if the combo box is Select Only.  

QCCR1E69003 In the Web Tier for Service Manager 7.11, 
if the value of the Subform Input property 
contains an apostrophe (for example, a 
Contact Name of "O'Malley, John"), the 
pop-up subform is prevented from 
opening.  

The pop-up subform renders correctly when the 
Input property contains an apostrophe.  

QCCR1E69316 In Trusted Sign-On (TSO) mode, when a 
user pressed F5 on the browser multiple 
times during initial communications 
between the client and server, multiple 
server sessions were established.  

In TSO mode, when the user launches the web 
client in a browser, a login progress screen 
displays, which instructs the user to wait and 
not to refresh the screen. Even if the user 
ignores this warning and presses F5 or the 
refresh button on the browser, Service Manager 
will not establish new sessions for the user.  

QCCR1E69436 At lower resolutions, an unnecessary 
horizontal scroll bar appears in certain 
forms.  

This issue occurred because the expected sizes 
of widgets were too large.  Now, control of the 
horizontal scroll bar is set as follows: 

Note: It is assumed that the screen resolution is 
not lower than 1024*768. 

• If the width of a detail form is smaller than 
500px, a horizontal scroll bar displays. 

• If the width of a detail form is larger than 
500px, Image widgets on the form will 
resize with the browser size; however, re-
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Global ID Problem Solution 

sizing of animated GIFs in Internet 
Explorer is not supported. 

• In some forms (for example, the System 
Status form (system.status.list.g), you may 
find the text on some buttons are truncated 
if your monitor is set to a lower screen 
resolution. If so, re-design the form 
(system.status.list.g), and reduce the width 
of the list table on the right side. On the 
other hand, if the height of the table is too 
large, you may find that the horizontal 
scroll bar is missing; in this case you can 
move the vertical scroll bar to the bottom of 
the page so that the horizontal scroll bar 
appears, and you can also reduce the height 
of the table in Forms Designer. 

QCCR1E69847 You cannot select more than two approval 
groups for the Change Management 
Security Profile.  

You can select more than two approval groups 
for the Change Management Security Profile.  

QCCR1E70013 When you open a linked record using a 
Fill button in a Web client, dropdown lists 
on the record that you opened do not work 
correctly. No options appear when you 
click a dropdown list.  

All dropdown lists work correctly in a Web 
client when you open a linked record using a 
Fill button. 

QCCR1E70511 A 
java.util.ConcurrentModificationException 
occurs when users use the HTML Viewer. 
This issue could occur when multiple 
clients are accessing the same HTML 
Viewer object simultaneously.  

No ConcurrentModificationException occurs 
when users use the HTML Viewer.  

QCCR1E71070 After a failed attempt of an employee self-
service (ESS) user to access Service 
Manager, the client session still remains 
for that user. This issue occurs in an 
LWSSO-enabled environment.  

The web client now terminates the session 
before forwarding the request to the 
authFailure.jsp page.  

QCCR1E71294 SOAP messages are not logged even 
though you set the tracesoap parameter to 
true.  

Soap message are now logged as expected if the 
user sets the tracesoap parameter to true.  

QCCR1E71421 The "Export to Excel/ Export to text" 
option is not working on the Web client 
(using Internet Explorer) when there is a 
marquee. The 'Your file had been exported 
successfully' message displays, but no file 
is saved and there is no dialog prompt to 
save or download file.  

When there is a marquee in the form, the 
"Export to Excel/ Export to text" option is now 
working correctly on both Internet Explorer and 
Firefox. 
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Global ID Problem Solution 

QCCR1E71734 The copyright date on the splash screen 
and the about page needs to be updated to 
the current year.  

Copyright date in the splash screen and about 
page are updated to the current year.  

QCCR1E72233 Some Comfill controls display an empty 
value instead of the appropriate value in 
the Web client.  

Comfill controls display the correct value.  

QCCR1E72743 The Web client ignores the "Invisible" 
settings in the fields of the "Data policy" 
table.  

The Web client no longer ignores the "Invisible" 
settings in the fields of the "Data policy" table.  
 
Known issues:  

• If a field within a structure is configured to 
be invisible in the data policy, it will still be 
visible. 

• If a field is configured as "invisible = true" 
and it is used in a select() expression as 
output, this field will still display the value 
of the field configured as "invisible=true" 
when this expression is used in a "value list 
condition" of another field. For example, the 
"value list condition" of the "New Update 
Type" field in the "IM.update.incident" form, 
is set as the following: 

"select("activity.name","activitytype","table", 
"probsummary","visible","YES")"  

If activity.name is configured as invisible, 
the value list will still be displayed in "New 
Update Type". 

QCCR1E73869 After deploying certain SM7.11 patches, 
the CM3R group widgets seem to overlap.  

After deploying certain SM7.11 patches, the 
CM3R group widgets are displayed normally.  

QCCR1E74013 By default, the MaxFileSize value of 
log4j.appender.R is only 100K. This value 
should be increased.  

Now by default, the maximum file size for sm 
web client log "sm.log" is increased to 5000K 
and up to 10 rolling files can be kept.  

Windows Client 

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E57462 Cannot mass update incidents, as an 
"Unrecoverable Error refreshing 
screen" occurred in the Windows 
client.  

Mass Update and Mass Close operations 
can be executed without triggering the 
exception now.  
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Global ID Problem Solution 

QCCR1E73687 When scrolling through documents in 
the Knowledge Management Pending 
Documents Queue, the Pending 
Documents list freezes after you 
select documents several times. The 
selected document does not load, and 
the Pending Documents list remains 
frozen indefinitely. The issue occurs 
when Record List is turned on. 
Additionally, an error message 
appears when you click the Next or 
Previous buttons.  

The Pending Documents list no longer 
freezes after you select documents several 
times, and the selected document is loaded 
correctly. When you click the Next or 
Previous button, no error messages appear.  

Server 

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E31928 Web Service RetrieveIncidentListRequest 
has the potential to cause a Java Heap Space 
out-of-memory error when retrieving a list of 
records.  

Updated the server code so that the 
following applies for the request response: 

• When there is neither a start 
attribute nor a count attribute, return 
all records/keys. 

• When there is a valid start value but 
no count attribute, return all records 
starting from the start attribute. 

• When there is a valid start attribute 
and valid count attribute, return the 
number of keys/records starting from 
the start attribute. 

• When there is a negative start 
attribute, return from the first record. 

• When there is a negative count 
attribute, return one record. 

• When the start attribute is bigger 
than the total number of records/keys, 
no record is returned.  

QCCR1E49322 When using the dbdict utility to rename the 
SQL name of a field, it fails if the current 
SQL name is a reserved word in the 
database.  

The column names in the generated 
statement are enclosed between double 
quotes, which allows the SQL name of a 
field to become a reserved word.  

QCCR1E51838 With Mandanten security enabled, the group 
views in the ToDo list display no records.  

The group views in the ToDo list display 
records correctly.  
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Global ID Problem Solution 

QCCR1E54248 When Service Manager processes a web 
service request and sends a response, the 
response is not understood by the requesting 
application. This behavior results in the 
following error message: 
"type" attribute in <cmn:messages> tag not 
matching Common.xsd schema definitions.  

A code change was implemnted in 
Common.xsd, so that "StringType" is 
always used as the base type of 
"MessageType."  

QCCR1E56867 Memory requirement for each thread on the 
server is high, as the XML response node is 
being duplicated.  

Eliminated the duplicate DOM object 
requirement.  

QCCR1E57907 The dbcount on joinsvcDisplay(JOIN) counts 
all records instead of those in qbe.  

The dbcount on joinsvcDisplay(JOIN) now 
counts records based on the query 
condition in qbe.  

QCCR1E59119 Servlet container processes crash when 
parsing a large query with more than 2500 
conditions.  

Servlet container processes do not crash.  

QCCR1E59527 In environments deploying a case-sensitive 
RDBMS in combination with a case-
insensitive LDAP server for authentication, 
it might be impossible for users to 
successfully log in to Service Manager (SM).  
 
After login, the System Navigator displayed 
an empty tree and the main screen was 
partially rendered, which resulted in an 
inability to use SM.  

If LDAP is used for authentication, users 
can now successfully log in with a 
lowercase, uppercase, or mixed-case user 
name and use SM properly after login.  
 
Without LDAP authentication, the case-
sensitivity of login depends on the case-
sensitivity setting of the RDBMS.  
 
Note: To take advantage of this fix, both 
the SM server and clients must be 
upgraded to SM 9.30p2 / SM 9.21.p5 
/7.11p19 or later. 

QCCR1E65095 The "Does not Contain" comparison does not 
work for an ARRAY text field.  

The "Does not Contain" comparison now 
works correctly for an ARRAY text field.   

QCCR1E65328 When running the "reportlic:1" command, it 
displays the correct count of Log-in Licenses 
for named and floating users. However, 
while comparing the output, named and 
floating users are not consistent between the 
summary and detail lists.  

The detail list displays the count of 
named and floating users correctly.  

QCCR1E65597 During upgrade, errors occur after a change 
to the dbdict on one of the following tables: 
code, format, link, counters, ScriptLibrary, 
scmessage, dbdcit, or datadict.  

Changes were made to close/reopen 
certain files if the dbdict is changed.  

QCCR1E66601 Formatting applied to Knowledge 
Documents was lost when the document was 

When invoking Use Solution on a 
Knowledge Document in an interaction 
record, formatting will be properly 
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Global ID Problem Solution 

used as a solution for an interaction.  applied to all HTML tags.  

QCCR1E67090 When running reports that include more 
than 7 array tables with the 6.2.8 ODBC 
driver, Crystal Reports crashes.  

The ODBC driver now allows 16 joined 
array tables at most.  

For more information, see Updated DLL 
Files for the ODBC Driver. 

QCCR1E67275 Number prefixes are not generated as 
expected.  

The number prefixes and suffixes are 
generated correctly even if there are no 
triggers on the number table.  

QCCR1E67562 Request for a way of turning off the 
"Triggers have been turned on" and 
"Triggers have been turned off" messages in 
the log file.  

Now, you can use the rtm parameter to 
turn the "Triggers have been turned on" 
and "Triggers have been turned off" 
messages on or off. 
To turn the messages on, set the value of 
the rtm parameter equal or greater than 
2.  

QCCR1E67592 Service Manager (SM) nodes are terminated 
when a user navigates to the incident queue. 
There are no log messages or other 
diagnostic information when the SM nodes 
are started from services, while an exception 
occurs when the nodes are started from the 
command line. This issue occurs when a 
globallist record that contains a tab 
character in its values is being called. 

SM nodes are no longer terminated when 
a globallist record that contains a tab 
character in its values is being called. 

QCCR1E67946 Slow system performance occurred and 
reviewing the system status revealed that 
several background processes were idle for 
over three hours.  

Fixed the Service Manager load balancer 
so that load is now distributed evenly 
across all available servlet containers.  

QCCR1E68005 When a user connects through Trusted Sign-
on (TSO) and exceeds the maximum number 
of concurrent logins, the server gives an 
error message.  

When the Service Manager client log-in 
fails, the correct message(s) will be 
displayed.  

QCCR1E68788 Performing a column sort in a View produces 
an error and client termination in UNIX-
based systems.  

No errors occur when performing a 
column sort in a View.  

QCCR1E68977 Several custom background processes are 
reading incoming records from Connect-IT 
(Inbound E-Mail, NetIQ, Webforms, etc.) and 
asynchronously creating interactions and 
incidents. JavaScript is being used and 
currently only the return code coming from 
.doAction can be validated.  
var rc = incFile.doAction("...") 
The validation message itself (for example: 

An SCFile.getMessages() function is 
provided for reading such messages 
directly in JavaScript code.  

For details about this function, see New 
Parameters and JavaScript Global 
Methods. 
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invalid category: Incident) is written to the 
sm.log file. Currently, developers and 
implementers cannot read this message 
directly in the JavaScript code instead of 
manually checking the log file.  

QCCR1E69154 Unable to see localized values and display 
lists on dynamic forms.  

Service Manager now uses the global lists 
variable 'display.variable' to set display 
list values and the proper language will 
be displayed.  

QCCR1E69423 After the RTE binary patch 9.21P3HF4 and 
web client 9.21P3HF4 were applied, there 
were issues when users worked in the web 
client. The session often aborted 
unexpectedly with following error: "Logout 
successful".  

The "Logout successful" error no longer 
occurs.  

QCCR1E69448 Signal 11 encountered when a user is 
updating an incident record: RTE E Caught 
XML API exception scxmlapi(40).  

When one user is inserting data or 
updating data in a file (for example, 
probsummary) while another user is 
updating the dbdict record at the same 
time, Service Manager no longer 
generates a "Signal 11" error.  

QCCR1E70053 When using an unsupported SQL data type 
in a SQL mapping in Service Manager 
during a record insert, a corrupt error 
message is displayed.  

Now, when using an unsupported SQL 
data type in a SQL mapping in Service 
Manager during a record insert, the 
correct error message is displayed 
including the numeric representation of 
the unsupported data type.  

QCCR1E70184 After applying Patch 14 to Service Manager 
7.0.2, the number of database connections 
increases over time until no further 
connections remain.  

The resource leak, which was introduced 
by HTTP GET requests, has been fixed.  

QCCR1E70218 An unload file from a DB2 system cannot be 
loaded into an Oracle system.  

The unload files can now be loaded from 
DB2 with no problem.  

QCCR1E70418 Service Manager servlets report a potential 
memory leak.  

Memory is now released properly when it 
is finished being used.  

QCCR1E70459 Service Manager (SM) versions 9.20 and 
later require that LDAP operators should 
match the case of the SM DB operators. 
However, this is not mandatory before 
SM9.20. After upgrading from SM version 
7.10 to version 9.2x or later, some users may 
not be able to log in anymore with an error 
"Invalid username/password".  

Now, login is case-insensitive, so end 
users can log in using "FALCON", 
"falcon", or "faLCon." Additionally, the 
case of the user name in the LDAP server 
does not need to match that in the 
RDBMS anymore.  

For more information, see Case-
Insensitive LDAP Login. 



 17 

Global ID Problem Solution 

QCCR1E70544 The Service Manager server experiences 
high CPU load and servlets stop responding 
to client requests. Over time, an 
administrator has to restart the service to 
recover from this condition.  

This high CPU load issue has been 
resolved.  

QCCR1E71047 When attempting to consume a third-party 
WSDL web service from Service Manager 
through an SSL channel and using Run 
WSDL to JS or a ScriptLibrary record, the 
connection aborts with the following error: 
 
22464(5750788) 11/23/2011 17:18:15 RTE 
E soap_sendRequest failed in step 0 
with rc 22 - errnum 0 
22464(5750788) 11/23/2011 17:18:15 RAD 
E SOAP request failed - TCP error 22 - 
SSL authentication failed in 
tcp_connect(): check password, key 
file, and ca file. 
22464(5750788) 11/23/2011 17:18:15 RAD 
E Script <unknown script> line 0: 
ERROR uncaught exception: SOAP request 
failed - TCP error 22 - SSL 
authentication failed in 
tcp_connect(): check password, key 
file, and ca file. at char 1  

Service Manager now can verify the 
certificate file and consume a WSDL web 
service.  

QCCR1E71099 Users need to display Value Lists instead of 
the data directly retrieved from the database 
in a QBE list when adding a field by using 
Modify Columns.  

Value Lists can be displayed instead of 
the data directly retrieved from the 
database in a QBE list when adding a 
field by using Modify Columns.  

Note: This server fix requires the 
QCCR1E71099_SM711P19.unl file from 
the platform_unloads directory. For more 
information, see Application unload 
installation. 

QCCR1E71853 The "NativeMemory" size never shrinks.  To resolve this issue, the 
usedmemcompmode parameter has been 
added. This parameter determines how 
used memory is calculated according to 
the following: 
 
0:used=committed + reserved;  
1:used=committed,no log;  
2:used=committed,log.  
 
The default is 0, which is the old Service 
Manager method.  

See also parameter usedmemcompmode. 

QCCR1E71918 The default value of parameter cache_slots, 
currently set at 2003 is too low. It should be 

The default value of cache_slots is now 
set to 9973.  
Note: If this parameter is not set or set to 
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set to a larger value (approximately 10000).  be greater than 100,000 or less than 300, 
the default value (9973) is used; if it is set 
to a non-prime number, the smaller one of 
its neighboring prime numbers is used 
instead.  

QCCR1E71934 Licenses are not being released when users 
log out from the system. The value output 
from the 'reportlic' parameter does not match 
the number of users on system status screen. 
As a consequence, the number of license slots 
run out and Service Manager has to be 
restarted to clear the issue. Licenses should 
be released when users log out from the 
system and 'reportlic' should match the 
number of users on system status screen.  

Now when users execute "sm -reportlic", 
Service Manager provides a mechanism 
to purge the zombie license users and 
release their licenses.  

QCCR1E72046 Log files report servlet terminations and out-
of-memory errors. A resource is locked and 
the system seems to hang.  

This issue was caused by running 32-bit 
applications on a 64-bit HP-UX system. 
To resolve this issue, the applications 
were recompiled to maintain 
compatibility on 64-bit HP-UX systems.  

QCCR1E72566 Service Manager performance on the AIX 
platform is significantly worse than other 
platforms when multiple users are executing 
workflows that make heavy use of 
JavaScript.  

Optimized JavaScript execution in SM for 
AIX so that property names are only 
retrieved as needed.  

QCCR1E72843 An attempt to add a field to the 
probsummary table in dbdict fails with a 
"Signal 11" error.  

This issue occurred because of a null 
pointer that causes the "Signal 11" error. 
This issue is resolved by verifying that a 
pointer is not null.  

QCCR1E73384 During normal operation of the HP 
Operations Orchestration 7 integration with 
Service Manager 7.11, the Service Manager 
server refuses Web service connections and 
issues the following warnings: 
"Server low on memory"  

This issue is caused by a memory leak. To 
solve this issue, a close() method is now 
called on the Page reference of the Lexer 
html parser to release the memory.  

QCCR1E73543 Bound variables in Oracle SQL statements 
cause significant performance issues when 
combined with Mandanten security 
restrictions. This issue is compounded by 
Mandanten because the Mandanten 
restrictions are duplicated in the SQL 
statements. This behavior results in 
additional bound variables.  

Now, the Mandanten query restriction is 
appended only once. 
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QCCR1E71099 Users need to display Value Lists 
instead of the data directly retrieved 
from the database in a QBE list 
when adding a field by using Modify 
Columns.  

Value Lists can be displayed instead of the data 
directly retrieved from the database in a QBE list 
when adding a field by using Modify Columns. 

Note: This is the application-side fix of the 
described issue. To completely solve the issue, 
upgrade the server to this patch and load the 
QCCR1E71099_SM711P19.unl file from the 
platform_unloads directory. See server fix 
QCCR1E71099 and Application Unload 
Installation. 

Documentation 

The following application updates are included in the current software release.  

Global ID Problem Solution 

QCCR1E47547 Help topic "JavaScript global 
method: makeSCWebURL":  
The example code is incorrect for 
this help topic. A variable named 
URL is created and returned 
without ever being set. It is webtier 
which is getting the return value for 
the makeSCWebURL and should be 
returned from this function, not 
URL.  

The example code in the topic should be updated to 
the following:  
 
function createURLquery( table, query) 
{ 
 
var url; 
var webtier; 
var webserver; 
var doceng; 
var hashkey; 
var action; 
 
print( "Parameters: table=" 
+ table + 
"query='" 
+ query + 
print( "Converting special characters in query to 
valid URI format..." ); 
queryURI = encodeURIComponent( query ); 
print( "Converted: old query='" 
+ query + 
"' new query='" 
+ queryURI + 
"'" ); 
 
webserver = "http://pdoref02/sc/index.do"; 
doceng = "docEngine"; 
hashkey = ""; 
action = ""; 
webtier = makeSCWebURL( webserver, 
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doceng, 
table, 
queryURI, 
hashkey, 
action); 
url=encodeURIComponent(webtier); 
print( "Creating URL from information provided..." 
); 
print( "The value of webtier is:\n" + webtier ); 
print( "The value of url is:\n" + url ); 
return url; 
} 
 
var tablename = "incidents" 
var SCquery = "incident.id=\"SD1001\"" 
 
createURLquery( tablename, SCquery);  

QCCR1E49518 No documentation is available about 
how relationship models are used 
with Change and Request types.  

The "Service Manager record relationship models" 
topic should be updated to the following: 
 
Service Manager Service Desk relationship models 
are methods to control the relationships between 
records inside Service Manager. The Service Desk 
relationship models affect four record types: 
Service Desk interaction records, Incident 
Management incident tickets, Change 
Management change requests, and Request 
Management quote orders. A Service Desk Agent 
can: 
 
Open an incident, complaint, or request for 
information in Incident Management. 
Open a request for change in Change 
Management. 
Open a Request Management quote to order a 
product or service. For example, if a user 
complains that a printer has stopped working and 
the Service Desk Agent determines that an older 
printer is not compatible with a new laptop, the 
agent can open a Request Management quote to 
order a new printer for the user. Once the order is 
placed, the Service Desk Agent can close the 
interaction record and add the quote order number 
for the new printer to the resolution note of the 
interaction. The quote order is also associated to 
the interaction record, so that even though the 
interaction is at a closed status the agent can refer 
back to the closed interaction to check the status of 
the related quote order. 
 
The following can be set in the Service Desk 
Environment Profile record and are models for 
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managing Service Desk record relationships: 
 
Full Service Desk Model: In this model, the state 
of a Service Desk interaction record changes when 
each related record closes. The closed state of an 
interaction record depends on the notification 
value chosen for the "Notify By" field in the 
interaction record.  For example, if the notification 
value is "Telephone," the interaction record has a 
required action before it is closed.  This action 
describes why the customer must be contacted.  It 
also prevents the interaction record from closing 
until all required actions are complete. In this 
case, the interaction record goes into the Open-
Callback state before it is closed. For more 
information, see Full Service Desk model. 
All Records close Independently: In this model, all 
Service Desk interaction records close 
independently. The state of related records does 
not affect closing an interaction record, and closing 
the interaction record does not affect related 
records. 
Close Interactions when Related Record closes: In 
this model, when the last related record closes, the 
Service Desk interaction record closes. 
Cannot close Related Record until Interactions are 
closed: In this model, records related to a Service 
Desk interaction cannot close until the interaction 
record is closed. 
Cannot close Interactions until Related Records 
are closed: In this model, a Service Desk 
interaction record cannot close until all related 
Incident Management tickets, Change 
Management requests, and Request Management 
quotes are closed. 
 
Note: The updated document will be available in 
the online help of the next release of Service 
Manager.  

QCCR1E71557 Documentation is needed on how to 
use the new configure.jar file of the 
server.  

The Service Manager server configure.jar file has 
been updated to enable encryption of the Service 
Manager database login credentials 
(username/password).  
For more information, see Encryption of the 
Database Login Credentials. 
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Known Problems, Limitations, and Workarounds 

This software release has the following limitation. 

Global ID Problem Workaround 

QCCR1E63663 The Service Manager (SM) client 
loses connectivity during 
JavaScript execution of the file.list 
RAD application.  

No workaround available. 

Created a knowledge article (KM1166532), 
which states that Service Manager does not 
currently support calls from JavaScript on 
RAD applications that use the rio/fdisp panels. 

Note: This information has been added to the 
HP Service Manager Programming Guide for 
the next version (Call a RAD application).  

QCCR1E57385 When Service Manager is running 
on Unix, the legacy listener may log 
intermittent signal 11 upon CIT 
initial connectivity test if exec-
shield is not set properly. 

Use one of the following solutions to solve this 
issue on Unix. 

Solution 1: 

Connect Connect-It to the Web Services 
connector instead of the Legacy Listener 
connector. 

Solution 2: 

Before connecting Connect-It to the Legacy 
Listener connector, do the following: 

1 Add  usethreading:0 in the sc.ini file, 
which is located in <Service Manager server 
installation 
path>\LegacyIntegration\RUN. 

 Note: For 64-bit RedHat Linux servers 
only, you can alternatively run the following 
shell commands as root: 

# sysctl -w kernel.exec-shield=0 

# sysctl -w kernel.randomize_va_space=0 

2 Start the legacy listener. 

QCCR1E69449 The user encountered a signal 11 
while updating an incident: RTE E 
Caught XML API exception 

scxmlapi(40). 

This is because another user was 
updating the probsummary dbdict 
record at the same time. 

When modifying a dbdict record, ensure that 
there are no other users updating records or 
inserting records in the same file. 

For example, when updating the probsummary 
dbdict, make sure that there are no other 
users updating existing incidents or opening 
new incidents. 
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QCCR1E67491 When the collation of the db 
instance is Chinese_PRC_BIN, Web 
service clients fail to connect to 
Service Manager (SM). Only ASCII 
operator names are supported, so 
only ASCII operator names can be 
used.  

Note: This issue only exists in Web service 
integrations. Therefore, the SM clients do not 
have this problem.  

When SM is handling an incoming SOAP 
request, the authorization string is decoded by 
BASE64Decoder. SM uses the decoded string 
value to construct a UTF-8 string that is used 
in the RTE. However, the authorization string 
is in the header and SM does not know the 
charset or encoding of the underling string 
value, which is BASE64 encoded. 

Therefore, if the underlying string value is not 
UTF-8 this problem will occur. In SM, when 
fetching an operator record from the database, 
no matter what collation the database uses, the 
operator record finally will get a UTF-8 
operator value. However, even if users put the 
same value in the authorization header, the 
operator name may differ because of the 
charset/encoding issue. Because of this, the 
operator will fail to log on.  

This is a limitation of SM. Do not use non-
ASCII characters in operator names. 

Created a knowledge article (KM1442479) to 
document this limitation. 

Installation Notes 

Before using patch 7.11.303 and all subsequent patches, you must manually remove the files listed below. 

Remove the following files from the server’s "\RUN\lib" directory:  

• saaj-impl-2.1.jar  

• saaj-api-2.1.jar 

• jgroups-all-2.5.0.jar 

Remove the following files from the server’s "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 

• xalan-jaxp-1.3.2.jar 

• jaxp-api-1.3.2.jar 

• dom-jaxp-1.3.2.jar 

• sax-jaxp-1.3.2.jar 
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Web Tier Installation 

The Web Tier update consists of a compressed file, sm711.532-P19_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. For more information, refer to the Service Manager Installation Guide. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. 

To install the Web Tier update: 

1 Back up your web.xml file, splash screen, style sheets, and any other customizations you made, including 
your webtier-7.11.war (or the .ear) file. 

2 Delete or uninstall the existing webtier-7.11.war (or the .ear) file. 

Note: The "Update Application" function in WebSphere Application Server 6.x allows you to redeploy 
using a new copy of webtier-7.11.war (.ear). First, update the web.xml in the webtier-7.11.war 
(.ear) file, and then redo the shared library configuration. For more information, see the IBM 
WebSphere documentation. 

3 Deploy the new webtier-7.11.war (or the .ear) file following the instructions in the Service Manager 
Installation Guide. 
 
Note: It is best practice to deploy with a unique context root. For example: /webtier-7.11.532 

4 Replace the new versions of any files you customized with your customized versions. 

5 Make any new customizations necessary for your deployment. Be sure to set the secureLogin and 
sslPort parameters. 

6 Restart the Application server. 
 
Note: Before accessing the new Web Tier, HP recommends that all users empty their browser cache. 

Windows Client Installation 

The client update consists of a compressed file, sm7.11.532-P19_Windows_Client.zip, which contains 
client.exe. 

To install the Windows client update: 

1 Stop the Service Manager Windows client. 

2 Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3 Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4 Check the version in Help > About Service Manager Client. The client should be Release: 7.11.532. 
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Server Update Installation 

The server update for your operating system (OS) consists of a compressed file, sm7.11.532-
P19_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the [SM 
Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 

To install the Server update: 

1 Stop all Service Manager clients. 

2 Stop the Service Manager server. 

3 Make a backup of the RUN directory. 

4 Extract the compressed files for your OS into the main Service Manager directory on the server. The 
default path is:  C:\Program Files\HP\Service Manager 7.11. 

5 For UNIX servers, set the file permissions for all Service Manager files to 755. 

6 Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar 
• saaj-api-2.1.jar 
• jgroups-all-2.5.0.jar 

7 Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 
• xalan-jaxp-1.3.2.jar 
• jaxp-api-1.3.2.jar 
• dom-jaxp-1.3.2.jar 
• sax-jaxp-1.3.2.jar 

8 Restart the Service Manager server. 

9 Restart the Service Manager clients. 

10 Check the version in Help > About Service Manager Server. The server should be Release: 7.11.532. 

Application Unload Installation 

If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant 
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this 
cumulative release. If you have not already applied them for a previous patch, you should also apply the 
unload files that are intended for your applications version. For more details about these applications 
updates, see the Release Notes for those patches. 

This patch release includes the unload files that come with the server update. When you extract 
sm7.11.532-P19_<OS>.zip (or .tar), it will add the files to the following directory:  
[SM Root]\platform_unloads ([SM Root]/platform_unloads)  

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 should be 
applied first, then those introduced in patch 2, and so on. However, unload files introduced in the same 
patch can be installed in a random order. 
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Unload File Naming Convention 

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where: 

• <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any). 

• SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 
and should be used for patch 2 or higher.  

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This 
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.  

• SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
which means the unload file is intended only for Service Manager applications version 7.11. 

Note: If the applications version suffix is omitted, the unload file is then intended for all applications 
versions compatible with the server version, unless otherwise specified. For example, 
QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 9.20, and 9.30 (which 
are compatible with Service Manager server 9.30), unless otherwise specified in the unload file 
description. For information on the applicable applications versions for each unload file included in the 
current patch, see Unload Files Included in the Current Patch. 

Unload Files Included in the Current Patch 

The following are unload files included in the current patch release.  

Unload file  Introduced 
in  7.11 
patch 

Used for 
apps 
version(s) 

Description 

QCCR1E71099_SM711P19.unl P19 7.11 Displays Value Lists instead of the data 
directly retrieved from the database in a 
QBE list when adding a field by using 
Modify Columns. See server fix 
QCCR1E71099. 

QCCR1E67072_SM711P18.unl P18 7.11 Improves the performance of the 
Knowledge Management update process 
(KMUpdate). 

QCCR1E67610_SM711P18.unl P18 7.11 Enables Service Manager to block 
potentially dangerous attachments. 

QCCR1E49721_SM711P17.unl 

 

P17 7.11 Allows a translation of Display/Value 
Lists on dynamic forms. This is a 
required fix for the Export to Excel 
redesign.  

QCCR1E56678_SM711P17.unl P17 7.11 Lists the records in the right group order 
when a record list is refreshed. 

QCCR1E58562_SM711P17.unl P17 7.11 Includes applications changes for the 
Export to Excel redesign.  
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Unload file  Introduced 
in  7.11 
patch 

Used for 
apps 
version(s) 

Description 

QCCR1E59385_SM711P16.unl 

 

P16 7.11 Improves performance by removing the 
duplicate select from JavaScript 
sloDisplay.getListSLOs.  
— If you haven't tailored the JavaScript 
sloDisplay, load 
QCCR1E59385_SM711P16.unl file  
— If you have tailored the JavaScript, 
see installation for tailored sloDisplay 
JavaScript in the SM711 patch 17 
release notes. 

QCCR1E59389_SM711P16.unl P16 7.11 Improves performance by removing extra 
selects from the various displayscreen 
and displaycache records.  

— If you haven't tailored the display 
screens, load 
QCCR1E59389_SM711P16.unl.  

— If you have tailored the display 
screens, see installation for tailored 
displayscreen and displaycache records 
in the SM711 patch 17 release notes. 

QCCR1E55713_SM711p15.unl P15 7.11 Includes application changes to reduce 
database I/O on login. 

QCCR1E57766_SM711p15.unl P15 7.11 Includes application changes to reduce 
jgroups traffic on login. 

QCCR1E55852_SM711p14.unl P14 7.11 Includes a new activity timer that makes 
the communication between SM 
processes more efficient. 

To load an unload file: 

1 Make sure the Windows client is configured for server-side load/unload.  

a) From the Windows client, go to Window > Preference > HP Service Manager.  

b) Unselect Client Side Load/Unload if is flagged.  

c) Restart the Windows client. 

2 Open Tailoring > Database Manager. 

3 Right-click the form or open the options menu and select Import/Load. 

4 Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 
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Field Description 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5 Click Load FG.  

ODBC Driver Update Installation 

The ODBC Driver update consists of the sm711.532_P19_ODBC.zip file, which contains the following 
updated files: 

• Scodbc32.dll 

• sci18n.dll 

• sccl32.dll 

To install the ODBC Driver update:  

1 Extract the files to your ODBC Driver installation folder, for example: C:\Program Files\Peregrine 
Systems\ServiceCenter 6.2\ODBC Driver. 

2 When prompted, replace the three old DLL files with the new ones. 

Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  

1 Use a browser to navigate to the Software Support Online (SSO) Web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 7.11 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

http://support.openview.hp.com/sc/support_matrices.jsp�
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Support 

You can visit the HP Software support web site at: 

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html 

http://h20230.www2.hp.com/new_access_levels.jsp�
http://h20229.www2.hp.com/passport-registration.html�
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notice 

© Copyright 1994-2012 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

• Adobe™ is a trademark of Adobe Systems Incorporated. 

• Java™ is a registered trademark of Oracle and/or its affiliates. 

• Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

• Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

• UNIX® is a registered trademark of The Open Group. 

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 
web site and search for the product manual called HP Service Manager Open Source and Third Party 
License Agreements. 
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